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Purpose of the BAP 

The Common User Management Portal (BAP) is intended to authenticate and authorize users wanting to connect to the Customs 

Information Systems of the Republic of Lithuania. BAP is also a common user management system that manages the activity 

profiles and rights as well as delegation agreements of the recipient's representatives. 
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1 LOGIN AND LOGOUT 

BAP is available at https://bap.lrmuitine.lt  

1.1 Login 

Choose "Login" to start log in to the system: 

 

Picture 1. Login 

 

When logging in, there are two ways to verify your identity with BAP: 

• Connecting via the E-Government Gateway. 

• Using a certificate issued by the customs of the Republic of Lithuania. If you use several certificates, clicking the "Certificate" 

button will display all the certificates you have, from which you will have to select one. 

 

Picture 2. Verify your identity 

 

Note: Using Chrome next time you connect, the list of certificates will only be displayed if you have previously closed all windows in 

that browser. 
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1. Connecting via Electronic Government Gateway 

Click the "E-Government Gateway" button: 

 

Picture 3. "E-Government Gateway" button 

 

You will be directed to a page where you can choose the authentication service method and provider: 

 

Picture 4. The authentication service methods and providers 

 

Note: Authentication methods and providers may change. 

Perform the authentication step. Some service providers may not direct you to the BAP service, in which case you may select the E-

Government Gateway service: 
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Picture 5.  E-Government Gateway service 

 

Depending on the authentication service provider, you will be directed to a page where you will need to confirm your consent to 

the transfer of personal data. 

Check the box as shown in the image below and click "Confirm" ("Patvirtinti"): 

 

Picture 6. Confirm your consent 

After confirmation, you will be redirected to the BAP service page. 
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2. Logging in with a certificate issued by the Customs of the Republic of Lithuania 

• To connect using a certificate, you must first verify your identity by connecting via Electronic Government Gateway and 

generate the certificate. 

How to generate a certificate is described in the section "Generating a certificate". 

• If you are not able to confirm your identity by connecting through the Electronic Government Gateway, submit an application 

to the Customs of the Republic of Lithuania to register as a service recipient. 

How to submit a request is described in the section "User registration and data change". 

Click the "Certificate" button: 

 

Picture 7. "Certificate" button 

 

You will be redirected to a page where you can select the certificate you want to sign in with: 

 

Picture 8. Select the certificate 

 

Note. If you use multiple certificates, we suggest using the Chrome browser. 
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1.2 Choice of the represented service recipient 

If you are a registered BAP user and represent only one services recipient, only that recipient's account will be logged in. If you 

represent multiple recipients of the service, a table of recipients will be provided for selection: 

 

Picture 1. Select services recipient 

1.3 Logout 

To log out of the BAP, click the "Logout" button: 

 

Picture1. Logout 

 

Note: If you work with several Customs systems, disconnecting from one system will automatically disconnect you from all the 

systems you have worked with. 
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2 USER REGISTRATION AND DATA MODIFICATION 

Users of the Customs systems of the Republic of Lithuania can join the BAP. There are two ways to register: 

• after confirming the identity by logging in via the Electronic Government Gateway, fill in the authenticated user form 

“Request to a services recipient”; 

• if it is not possible to confirm the identity via the Electronic Government Gateway, the Customs of the Republic of Lithuania 

shall submit a request to register as a services recipient by filling in the form “Request to register a services recipient ” using 

the link in the login window. 

2.1 Authenticated user registration 

To register, follow these steps: 

1. Confirm your identity by connecting via the E-Government Gateway (see Login and logout ). 

2. When the Common User Management Portal (BAP) page opens, click "Confirm": 

 

Picture 1. Confirm your identity 

 

Note. When connecting via the Electronic Government Gateway as a natural person, a natural person registration form will be 

provided. 

When connecting via the Electronic Government Gateway as a representative of a legal entity, a registration form for an individual 

and a legal entity will be provided. 
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2.1.1 Registration of a natural person as a recipient of services 

1. In the form of Application for registration of services recipient fill in the fields and click "Continue filling": 

 

Picture 2. Registration of a natural person Step 1 

 

2. In the review form of the request to register a recipient of services check the entered data, mark that you are familiar with the 

rules for the provision of electronic services and click "Submit": 



BAP USER GUIDE 

BENDRO NAUDOTOJŲ VALDYMO SISTEMOS, ATITINKANČIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKŪRIMO 
PASLAUGŲ PROJEKTAS 

 
 

 12 

2.2 Unauthenticated user registration 

If you are not able to confirm your identity by connecting through the Electronic Government Gateway, submit an application to 

the Customs of the Republic of Lithuania to register as a services recipient. After examining the application, you will be given a 

certificate with which you will be able to confirm your identity by connecting to the Customs Systems of the Republic of Lithuania. 

To apply for registration of services recipient, follow these steps: 

1. In the Login window, open the "Registration" ink: 

 

Picture 1. Registration 

 

2. At Registration window choose a link "Submit a request to register as a recipient of services": 

 

Picture 2. Submit a request to register as a recipient of services 
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3. Fill in the application form provided. Below is the registration form for a natural person. 

4. Save the data by clicking the "Submit" button: 

 

Picture 3. Submitting 

 

After submitting the data, it will be transferred to the Customs of the Republic of Lithuania and the Customs officials will contact 

you by your e-mail address for clarification of information (if required) and issuance of a certificate of access. 
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2.3 Changing profile data 

The user is allowed to change the e-mail, postal address, and method of obtaining a reply (for legal persons only) and provide 

additional data such as EORI, VAT identification number, number of the certificate of professional qualification of customs 

representation. To change profile data, follow these steps: 

1. Select "Profile" from the top menu. The opened window shows the data of the connected user (representative) and the selected 

services recipient: 

 

Picture 1. Menu Profile 

 

2. Click the "Edit" button at the bottom of the window: 

 

Picture  2. Edit profile information 

 

3. Modify or complete the form with the desired data. If certain data cannot be changed, the fields are inactive. 

4. Save your changes by clicking the "Save" button: 

 

Picture 3. Save changes 
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3 VIEW THE DETAILS OF THE RECIPIENT AND THE RECIPIENT'S 

REPRESENTATIVE 

To view the details of the services recipient and/or the recipient's representative, select the "Profile" tab in the top menu. 

 

Picture 1. Profile tab selection 

 

There are two possible cases: 

• The recipient's representative is the same person as the recipient 

• The services recipient and the representative of the services recipient are different persons. 
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3.1 View data when the recipient and the recipient's representative match 

1. The top of the "Profile" page displays the profile information, i.e. the registration identification number of the service recipient's 

account and the representative of the service recipient, the details of the service recipient's representative: "Certificates", 

"Business profiles and permissions": 

 

Picture 1. Profile information: certificate information, business profiles and permissions of the service recipient and his 

representative 

 

To view the details of a specific activity profile, click on the row of the activity profile entry in the list of activity profiles. A pop-up 

window will display all the information. 

 

Picture 2. Business profile details 
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The layout of the service user data is shown below: 

• "Representation in customs" - shown only for a natural person. 

• At the bottom of the page, there is an "Edit" button, which gives the possibility to edit the data of the service recipient 

profile. 

 

Picture 3. Profile information: address, contact details, method of receiving notifications 

 

 

 

 

 

 

 

 

 

 

 



BAP USER GUIDE 

BENDRO NAUDOTOJŲ VALDYMO SISTEMOS, ATITINKANČIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKŪRIMO 
PASLAUGŲ PROJEKTAS 

 
 

 18 

3.2 View data when the services recipient and the representative of the services recipient 

are different persons 

1. The top of the "Profile" page displays the profile information, i.e. the registration identification number of the service recipient's 

account and the representative of the service recipient, "Business profiles and permissions" details: 

 

Picture 1. Profile information: business profiles and permissions of the service recipient and his representative 

 

To view the details of a specific activity profile, click on the row of the activity profile entry in the list of activity profiles. A pop-up 

window will display all the information. 

 

Picture 2. Business profile details 

 

3. The layout of the service user data is shown below: 

• "Representation in customs" - shown only for a natural person. 
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• "Notification reception type" - selected method and address to which messages from Customs information systems might be 

sent. 

• At the bottom of the page, there is an "Edit" button, which gives the possibility to edit the data of the service recipient 

profile. 

 

Picture 3. Profile information: representation in customs, address, contact details, method of receiving notifications 
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4 CERTIFICATE GENERATION 

In order to receive a Lithuanian customs certificate, you must first confirm your identity by connecting through the Electronic 

Government Gateway. 

If you cannot confirm your identity by connecting via the Electronic Government Gateway, submit an application to the Customs of 

the Republic of Lithuania to register as a recipient of services. 

See section "User registration and data modification", section "Unauthenticated user registration". 

4.1 Generating a certificate offline 

If you are already registered as a service recipient but are unable to log in with your existing certificate, select the "Generate new 

certificate" link in the "Login" window: 

 

Picture 1. Generate new certificate 

 

In the new certificate order window, enter your email address to receive a confirmation link, which will allow you to generate a 

new certificate. 

Once you have provided your email address, select the "Submit" button: 

 

Picture 2. Requesting a new certificate 
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Once you have activated the link you received by email, please follow these steps: 

1. Certificate request creation. Upload the CSR file from your computer and select the "Order certificate" button. The creation of 

the CSR file is described in the "Creating a certificate signing request" section of the "Instructions for certificate preparation", 

depending on the operating system used. 

 

Picture 3. Certificate request creation step 

 

2. Certificate download. Download the certificate by selecting the "Download" link. After downloading the certificate, select the 

"Install" button: 

 

Picture 4. Certificate download step 

 

Make sure you have downloaded the certificate again and select the "Yes, I downloaded it" button in the pop-up window: 
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Picture 5. Confirmation about downloaded certificate 

 

3. Certificate installation. To use a certificate to connect to the BAP, install it in the browser you are using. On the certificate file, 

call the install certificate function and follow the wizard instructions: 

 

Picture 6. Certificate installation step 

Remark. The same steps need to be followed if you are generating a certificate for the first time after receiving a link via email. 

 

4.2 Generating and adding a certificate after logging into the portal 

Once you have logged in to the portal and selected to represent yourself to generate a certificate, please follow these steps: 

1. Select the "Profile" tab from the top menu: 

 

Picture 1. Menu Profile 

 

 

 



BAP USER GUIDE 

BENDRO NAUDOTOJŲ VALDYMO SISTEMOS, ATITINKANČIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKŪRIMO 
PASLAUGŲ PROJEKTAS 

 
 

 23 

2. In the "Certificates" section, click on the "Add New" button. 

 

Picture 2. Add new certificate 

 

3. In the "Adding new certificate" pop-up window that appears for adding an LR customs certificate, select the value "Certificate 

issued by the customs of the Republic of Lithuania - for connecting to customs portals and accessing customs e-mails provided by 

system to system services." and click the "Continue" button.  

 

Picture 3. Choosing a certificate 

 

4. If you already have a certificate, to generate a new certificate, click on "Generate new certificate". 

 

Picture 4. Approve you want to generate new certificate 

 

5. After selecting the "Generate new certificate" button, you will be redirected to the "Generate certificate" window. In the opened 

window, upload the generated file in CSR format and click on the "Generate certificate" button: 
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Picture 5. Customs of Lithuania for authentication certificate generation 

Note: You can hold one valid permanent certificate at a time. If you have a valid certificate and generate a new one, the old one 

will automatically expire. 

 

6. To add a certificate issued by another issuer, select the value "Certificate issued by another issuer - for access to customs and 

European Commission e-mails provided by system to system services" in the "Adding a new certificate" pop-up window that 

appears and click the "Continue" button: 

 

Picture 6. Choosing a certificate 

 

7. The "Adding a certificate for signing" window that opens shows you what you need to do to sign a document with a certificate. 

Upload the signed document in PDF format and click the "Add certificate" button: 



BAP USER GUIDE 

BENDRO NAUDOTOJŲ VALDYMO SISTEMOS, ATITINKANČIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKŪRIMO 
PASLAUGŲ PROJEKTAS 

 
 

 25 

 

Picture 7. Adding other issuer's certificate for signing 

Note: You can have more than one valid certificate issued by another issuer for signing at the same time. 

For digital signing of an uploaded PDF signing document, please refer to the instructions "Signing a PDF document with a 
certificate using Adobe Acrobat Reader". 

8. To download the certificate data, select the row of the certificate record under "Certificates". 

 

Picture 8. Download certificate data 

 

9. Clicking on an entry line will bring up the "Certificate details" pop-up window, where you can confirm the certificate data 

download action by clicking on the "Download" button. 

 

Picture 9. Confirmation of certificate data download 

 

10. A "sertifikatas.cer" file will be sent to your computer. 
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4.3 Certificate removal 

To remove a certificate, follow these steps: 

1. Select "Profile" in the top menu. 

2. In the "Certificates" section, click the "Remove" button in the row of the certificate record. 

 

Picture 1. Removing a certificate 

 

3. Click the "Remove" button in the pop-up window. 

 

Picture 2. Approve the remove 
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4.4 Instructions for certificate preparation 

4.4.1 Introduction 

To login to BAP using a certificate, you must first prepare a certificate signing request. With this request, a certificate is generated 

which must be installed on your computer. Below are instructions on how to generate a certificate signing request on each 

operating system, how to download the certificate, install it, and transfer it to another computer. 

 

• Certificate management in Windows environment 

• Certificate management in MacOS environment 

• Certificate management in Linux environment 

 

If you are using a Windows environment, you will need to download the following file to proceed: request.inf. 

4.4.2 Certificate management in Windows environment 

4.4.2.1 Creating a certificate signing request 

The following sections describe two ways in which this can be done in a Windows environment. Choose the one that suits you 

better and follow the steps below. 

• Using the Microsoft Management Console 

• Using Command Prompt 

 

4.4.2.1.1 Using the Microsoft Management Console 

1. First, prepare a location on your computer where you can later save the certificate request created in the next steps of these 

instructions. We recommend that you create a folder named "bapcrt" at "Computer" → "Local Disc (C :)". The example below 

shows the folder "bapcrt" created in an analogous location at "This PC" → "Windows (C :)". 

 

Picture 1. Creating the bapcrt folder 

 

2. To open the user certificates manager, type "certificates" in the "Windows Start" bar to search for and choose "Manage user 

certificates". 
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Picture 2. Search in Windows Start bar 

 

3. Right-click on "Personal" catalog to bring up the internal menu. From this menu, select "All Tasks" → "Advanced Operations" → 

"Create custom request". 

 

Picture 3. Manage user certificates window 

 

4. In opened "Certificates Enrollment" window click "Next". 

 

Picture 4. Certificate Enrollment window 
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5. The next window will suggest a strategy for applying the certificate. In "Custom Request" select "Proceed without enrolment 

policy" and click "Next". 

 

Picture 5. Strategy selection window 

 

6. In the next step expand "Template" dropdown meniu and select "(No template) Legacy key". Note the format "PKS # 10" and 

click "Next". 

 

Picture 6. Template selection 

 

7. In the certificate information window, expand the "Details" and click the "Properties" button. 
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Picture 7. Certificate Information Window 

 

8. Select the "Subject" tab in an opened window. 

 

Picture 8. Subject tab 
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9. In the "Type" dropdown menu select "Common name". 

 

Picture 9. Subject name type selection 

 

10. In the "Value" field enter your Name and Surname and click Add>. 

 

Picture 10. Subject name value 
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11. In the "Type" dropdown menu select "Given name", in "Value" field enter your name and click "Add>". 

 

Picture 11. Filling in subject data 

 

12. In "Type" dropdown menu select "Surname", in "Value" field enter your name and click "Add>". 

 

Picture 12. Filling in subject data 
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13. When the "Subject name" values are filled in you can see them on the right pane with attributes CN, G, SN. 

 

Picture 13. Subject name result 

 

14. In the "Alternative name" section select "Email" from "Type" dropdown menu, enter your email address in "Value" field and 

click "Add>". 

 

Picture 14. Alternative name data 
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15. When the "Alternative name" value is filled in you can see email attribute on the right pane. 

 

Picture 15. Alternative name result 

 

16. Select "Private Key" tab section. 

 

Picture 16. Private key tab selection 
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17. Expand the "Key type" area and select the "Exchange" option. 

 

Picture 17. Key type selection 

 

18. Once you have selected the key type, you need to choose which algorithm is used to encrypt the data. To do this, expand the 

"Cryptographic Service Providers" section and make sure that only one option "Microsoft RSA SChannel Cryptographic Provider 

(Encryption)" is selected. 

 

Picture 18. Encryption algorithm selection 
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19. Finally, you need to specify the key size by expanding the "Key options" section, selecting "2048" next to Key size and marking 

the "Make private key exportable" checkbox. 

 

Picture 19. Key size selection 

 

20. After completing all the above steps, click on the "OK" button and you will be returned to the "Certificate Enrollment" wizard. 

 

Picture 20. Certificate properties window closing 
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21. In "Certificate Enrollment" wizard click "Next" button. 

 

Picture 21. Certificate Enrollment wizard 

 

22. The next step is to specify the disk location where you want to save the certificate request. To do this, click on the "Browse..." 

button. 

 

Picture 22. Query save dialog 

 

23. Select where you want to save the file. 

It is recommended to store the file in the directory "bapcrt" created at the address given in step 1. 
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Picture 23. File save dialog 

 

24. It's important to save a file with a "csr" extension - to do this, add ".csr" ending to the file name and specify "All files (*. *)" 

option in the "Save as type" field. Click "Save" in the dialog box after completing all the steps. 

 

Picture 24. File save dialog 

 

25. You will be returned to the "Certificate Enrolment" wizard. Click the "Finish" button. The CSR has been generated successfully 

and saved to the file you specified. 

 

Picture 25. End of the wizard 
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Continue generating the certificate from the "Download and install the certificate" chapter. 

4.4.2.1.2 Using Command Prompt 

1. Create a "request.inf" file. The contents of the file are listed below. 

Note 
You can download the prepared "request.inf" file in the certificate generation window or on the login page. 

 

Picture 26. Download of the request.inf file for authenticated BAP user 

 

After downloading the file, please enter your full name (CN, G, SN) in the "Subject" line instead of "Name Surname" and your email 

address in the "_continue_" line. 

;----------------- request.inf ----------------- 

[Version] 

Signature="$Windows NT$" 

  

[NewRequest] 

Subject = "CN=Name Surname, G=Name, SN=Surname" 

KeySpec = 1 

KeyLength = 2048 

Exportable = True 

MachineKeySet = False 

SMIME = False 

PrivateKeyArchive = FALSE 

UserProtected = FALSE 

UseExistingKeySet = FALSE 

ProviderName = "Microsoft RSA SChannel Cryptographic Provider" 

ProviderType = 12 

RequestType = PKCS10 

KeyUsage = 0xa0 

  

[Extensions] 

2.5.29.17 = "{text}" 

_continue_ = "email=email@example.com" 

  

[EnhancedKeyUsageExtension] 

OID=1.3.6.1.5.5.7.3.1 

;----------------------------------------------- 

Note 
If you have not used the BAP system before and do not have the possibility to log in via the eGovernment Gateway, please see 
the section "Download and install the certificate". 
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Important 
When saving the file "Encoding" must be selected "ANSI". 

 

Picture 27. Choosing a file encoding 

 

2. Open the "cmd" command line. To do this, type "cmd" in the address bar of the current "bapcrt" folder and press the "Enter" key 

on your keyboard. 

 

Picture 28. Opening CMD through the address bar 

 

 

Picture 29. CMD line window 

 

3. In the opened window, enter the following command: 

C:\bapcrt> certreq -new request.inf request.csr 

 

Picture 30. Example of command entry 
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After successfully creating "request.csr", you will receive a response from the command line: 

CertReq: Request Created 

 

Picture 31. Response 

 

 

Picture 32. Creating a file request.csr 

4.4.2.2 Certificate download and installation 

1. If you have not used the BAP system before and do not have the possibility to log in via the Electronic Government Gateway, 

please send the prepared "request.csr" file by email to the customs office when requested. You will receive a reply with the 

sertifikatas.crt attached file, which you should save in the "bapcrt" directory you created. 

If you can log in to BAP using the authentication service provided by the Electronic Government Gateway, or if you have already 

used the BAP system in the past and you are able to login to it, click on the "+Add New" button in the "Profile" section, select the 

value "Certificate issued by the customs of the Republic of Lithuania - for connecting to customs portals and accessing customs 

system to system services." in the "Adding a new certificate" modal window, then click on the "Continue" button. 

 

Picture 33. "Customs of Lithuania for authentication" selection 
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Bookmark the file "request.csr" in the "Generate Certificate" window and click on the "Generate Certificate" button. 

Figure 1 CSR file upload location 

 

Picture 34. Uploading the CSR file 

 

Download the "sertifikatas.crt" file by clicking the "Download" button in the pop-up window or in the certificate data table. Move 

the downloaded file to the "bapcrt" directory. 

Figure 2 CRT file download  

 

Picture 35. Downloading the CRT file 

Note 
The certificate can also be downloaded from the "Profile" certificate list by selecting the row of the certificate entry in the list and 
clicking the "Download" button. For more information see "Generating and adding a certificate after logging into the portal". 
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Picture 36. Creating sertifikatas.crt file 

 

2. Import the certificate into the user certificate cache. Right-click on the "sertifikatas.crt" file and select "Install Certificate" in the 

pop-up window that opens. 

 

Picture 37. Importing a certificate into the user certificate cache 
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Picture 38. Certificate Import Wizard: placement location selection 

 

 

Picture 39. Certificate Import Wizard: specifying the location 
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Picture 40. Certificate Import Wizard: Reviewing settings 

 

 

Picture 41. Certificate Import Wizard: notification of the successful completion of a certificate import 

4.4.2.3 Preparing a certificate to run on another computer 

1. To open the user certificates manager, type "certificates" in the "Windows Start" bar to search for and choose "Manage user 

certificates". 

 

Picture 42. Search in the Windows Start bar 
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You should see the imported certificate in the "Certificates" directory. 

 

Picture 43. View the imported certificate 

 

6. Check that the certificate has the appropriate private key. If you double left-click on the certificate, you should see "You have a 

private key that corresponds to this certificate". 

 

Picture 44. Certificate private key verification 

 

7. Export the certificate along with the private key to a file so you can use it on other computers and have a backup: 

 

Picture 45. Certificate Export 
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8. In the "Certificate Export"  wizard, click the "Next" button. 

 

Picture 46. Certificate Export Wizard 

 

9. Mark "Personal Information Exchange - PKCS #12 (.PFX)", mark checkbox "Include all certificates in the certification path is 

possible" and "Enable certificate privacy" and click "Next". 

 

Picture 47. Certificate Export Wizard: Format selection 

 



BAP USER GUIDE 

BENDRO NAUDOTOJŲ VALDYMO SISTEMOS, ATITINKANČIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKŪRIMO 
PASLAUGŲ PROJEKTAS 

 
 

 48 

10. Select "Yes, export the private key" to export the private key together with the certificate and click "Next". 

 

Picture 48. Certificate Export Wizard: Exporting a private key 

 

11. Create a password that will protect the private key of the certificate and click "Next". 

 

Picture 49. Certificate Export Wizard: Creating a password 
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12. Specify the export location and file name through "Browse..." function and click "Next". 

 

Picture 50. Certificate Export Wizard: Creating file name 

 

13. Review the settings and complete the export operation and click "Finish". 

 

Picture 51. Certificate Export Wizard: Settings review 
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14. After completing this step you will be notified of successful completion of the export. 

 

Picture 52. Certificate Export Wizard: Notification of the successful completion of a certificate export 

 

15. . The resulting "sertifikatas.pfx" file contains your certificate and its private key. You can easily import it to another computer. 

 

Picture 53. Display of the exported sertifikatas.pfx file 
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4.4.3 Certificate management in MacOS environment 

4.4.3.1 Creating a certificate signing request 

If you are using macOS , you can generate a certificate request using the "openssl" command via a terminal. 

1. For your convenience, we recommend that you create a new folder (such as "bapcrt") on your desktop. 

  

Picture 1. Creating a folder 

 

2. Launch the "Terminal" app. This can be done by using the Command-Space bar and typing "terminal" in the search field: 

 

Picture 2. Terminal launching 

 

OR  by selecting "Go" → "Utilities" in the "Finder" menu: 

   

Picture 3. Terminal launching 
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3. In the terminal, navigate to the "bapcrt" directory you created by typing the command (press the "Enter" key to execute the 

command): 

cd Desktop/bapcrt 

 

4. Generate a certificate request using the "openssl" command: 

openssl req -out request.csr -utf8 -new -newkey rsa:2048 -nodes -keyout certificate.key \   
-subj "/GN=Name/SN=Surname/CN=Name Surname" \   
-reqexts SAN \   
-config <(cat /etc/ssl/openssl.cnf <(printf "\n[SAN]\nsubjectAltName=email:mail@email.com")) 

 

5. Check available files: 

JN-iMac:bapcrt Jonas$ ls -l 
total 16 
-rw-r--r--  1 Jonas  staff  1704 Sau 29 21:29 certificate.key 
-rw-r--r--  1 Jonas  staff   915 Sau 29 21:29 request.csr 

4.4.3.2 Certificate download and installation 

1. If you have not used the BAP system before and do not have the possibility to log in via the Electronic Government Gateway, 

please send the prepared "request.csr" file by email to the customs office when requested. You will receive a reply with the 

sertifikatas.crt file, which you should save in the "bapcrt" directory you created. 

If you can log in to BAP using the authentication service provided by the Electronic Government Gateway, or if you have already 

used the BAP system in the past and you are able to login to it, click on the "+Add New" button in the "Profile" section, select the 

value "Certificate issued by the customs of the Republic of Lithuania - for connecting to customs portals and accessing customs 

system to system services." in the "Adding a new certificate" modal window, then click on the "Continue" button. 

 

Picture 4. "Customs of Lithuania for authentication" selection 

 

2. Bookmark the file "request.csr" in the "Generate Certificate" window and click on the "Generate Certificate" button. 
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Picture 5. Uploading the CSR file 

 

3. Download the "sertifikatas.crt" file by clicking the "Download" button in the pop-up window or in the certificate data table. 

Move the downloaded file to the "bapcrt" directory. 

 

Picture 6. Downloading the CRT file 

Note 
The certificate can also be downloaded from the "Profile" certificate list by selecting the row of the certificate entry in the list and 
clicking the "Download" button. For more information see "Generating and adding a certificate after logging into the portal". 

 

4. Catalogue content: 

JN-iMac:bapcrt Jonas$ ls -l 

total 12 

-rw-r--r--  1 Jonas  staff  1704 Sau 29 21:29 certificate.key 

-rw-r--r--  1 Jonas  staff   915 Sau 29 21:29 request.csr 

-rw-r--r--  1 Jonas  staff   915 Sau 29 21:29 sertifikatas.crt 
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5. Generate a PFX file from the certificate and key files. Create a password that will protect the private key. 

openssl pkcs12 -export -out sertifikatas.pfx -inkey certificate.key -in 

sertifikatas.crt 

Figure 3 Example of export 

 

Picture 7. Example of export 

 

6. Check available files: 

JN-iMac:bapcrt Jonas$ ls -l 

total 12 

-rw-r--r--  1 Jonas  staff  1704 Sau 29 21:29 certificate.key 

-rw-r--r--  1 Jonas  staff   915 Sau 29 21:29 request.csr 

-rw-r--r--  1 Jonas  staff   915 Sau 29 21:29 sertifikatas.crt 

-rw-r--r--  1 Jonas  staff   915 Sau 29 21:29 sertifikatas.pfx 

sertifikatas.pfx - a file that contains your certificate and its private key. 

 

7. To import a certificate from the "Finder", select "Go" -> "Utilities" and start the "Keychain Access" application. 
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Picture 8. Importing a certificate on macOS 

 

4. On the left side of the "Keychain Access" application, select "System". 

 

Picture 9. "System" selection 



BAP USER GUIDE 

BENDRO NAUDOTOJŲ VALDYMO SISTEMOS, ATITINKANČIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKŪRIMO 
PASLAUGŲ PROJEKTAS 

 
 

 56 

5. From the "File" menu, select "Import Items…" function. 

 

Picture 10. „Import Items...“ selection 

 

6. Select the generated certificate. 

 

Picture 11. Certificate selection 
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7. After selecting the certificate, the system will ask you to enter the administrator password, followed by the password of the 

generated certificate that was created in step 2. 

 

Picture 12.  

Once the certificate has been imported, a new Safari browser will allow you to log in to bap.lrmuitine.lt by selecting the certificate. 

The first time you log in, macOS System will ask you again for your administrator name and password. These will then be used to 

log in to the system. 

4.4.3.3 Preparing the certificate to work on another computer 

The PFX file, which was generated in step 2 of "Download and install the certificate", is required for work on another computer. 

Transfer this file to the new computer and continue with the steps described in the installation instructions below. 

4.4.4 Certificate management in Linux environment 

4.4.4.1 Creating a certificate signing request 

If you are using Linux, you can generate a certificate request using the "openssl" command via a terminal. 

 

1. First of all, prepare a location on your computer where you will store the certificate request created in the following steps, for 

this we recommend creating the directory "bapcrt". Navigate to this directory and generate the certificate request using the 

"openssl" command: 

linux@PC$ openssl req -out request.csr -utf8 -new -newkey rsa:2048 -nodes -keyout 

certificate.key \ 

  -subj "/GN=Name/SN=Surname/CN=Name Surname" \ 

  -reqexts SAN \ 

  -config <(cat /etc/ssl/openssl.cnf \ 

        <(printf "\n[SAN]\nsubjectAltName=email:mail@email.com")) 

 

2. Check available files: 

linux@PC$ ls -l 

total 8 

-rwxrwxrwx 1 root root 1704 May  7 15:37 certificate.key 

-rwxrwxrwx 1 root root  980 May  7 15:37 request.csr 

4.4.4.2 Certificate download and installation 

1. If you have not used the BAP system before and do not have the possibility to log in via the Electronic Government Gateway, 

please send the prepared "request.csr" file by email to the customs office when requested. You will receive a reply with the 

sertifikatas.crt file, which you should save in the "bapcrt" directory you created. 

If you can log in to BAP using the authentication service provided by the Electronic Government Gateway, or if you have already 

used the BAP system in the past and you are able to login to it, click on the "+Add New" button in the "Profile" section, select the 

value "Certificate issued by the customs of the Republic of Lithuania - for connecting to customs portals and accessing customs 

system to system services." in the "Adding a new certificate" modal window, then click on the "Continue" button. 
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Picture 1. "Customs of Lithuania for authentication" selection 

 

2. Bookmark the file "request.csr" in the "Generate Certificate" window and click on the "Generate Certificate" button. 

 

Picture 2. Uploading the CSR file 

 

3. Download the "sertifikatas.crt" file by clicking the "Download" button in the pop-up window or in the certificate data table. 

Move the downloaded file to the "bapcrt" directory. 
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Picture 3. Downloading the CRT file 

Note 
The certificate can also be downloaded from the "Profile" certificate list by selecting the row of the certificate entry in the list and 
clicking the "Download" button. For more information see "Generating and adding a certificate after logging into the portal". 

 

4. Catalogue content: 

linux@PC$$ ls -l 

total 12 

-rwxrwxrwx 1 root root 1704 May  7 15:37 certificate.key 

-rwxrwxrwx 1 root root  980 May  7 15:37 request.csr 

-rwxrwxrwx 1 root root 1127 May  7 15:41 sertifikatas.crt 

 

5. Generate a PFX file from the certificate and key files. Create a password that will protect the private key. 

linux@PC$:/mnt/d/bapcrt/linux$ openssl pkcs12 -export -out sertifikatas.pfx -inkey 

certificate.key -in sertifikatas.crt 

Enter Export Password:  

Verifying - Enter Export Password: 

 

6. Check available files: 

linux@PC$:/mnt/d/bapcrt/linux$ ls -l 

total 16 

-rwxrwxrwx 1 root root 1704 May  7 15:37 certificate.key 

-rwxrwxrwx 1 root root  980 May  7 15:37 request.csr 

-rwxrwxrwx 1 root root 1127 May  7 15:41 sertifikatas.crt 

-rwxrwxrwx 1 root root 2389 May  7 15:43 sertifikatas.pfx 

sertifikatas.pfx - a file that contains your certificate and its private key. 

 

7. Importing a certificate for use on a Linux system is configured in the browser. Open your browser settings, locate the "Privacy & 

Security" section, select "Certificates" option and click "View Certificates". 
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Picture 4. "View Certificates" tab 

 

8. In an opened window in the "Your Certificates" section, click "Import", specify your PFX file and the password you specified in 

step 3. 

 

Picture 5. Certificate installation window 

 

9. After the certificate has been uploaded successfully, you will see it in the list. 
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Picture 6. List of certificates 

4.4.4.3 Preparing the certificate to work on another computer 

To work on another computer, you need the PFX file that was generated in step 2 in the section "Download and install the 

certificate". Transfer this file to a new computer and continue with the steps in the installation instructions below. 

4.5 Signing a PDF document with a certificate using Adobe Acrobat Reader 

To sign a downloaded document for signature, follow these steps. 

1. Download the PDF document and open the file. 

 

1 pav. Download a document 
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4. In the open document, click on the signature area. 

 

2 pav. Signing a document: selecting the signature area 

 

4. In the "Sign with a Digital ID" window that opens, select the signature you want to sign with from the list and click the "Continue" 

button. 

 

3 pav. Signing a document: choosing a digital identity 

 

5. The "Sign as 'First name Last name'" box will display the standard text of the signature. Click on the "Sign" button.  
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4 pav. Signing a document: choosing a signature display 

 

6. Follow the on-screen instructions - depending on the type of certificate, you may be asked to provide a certificate PIN, password 

or other information identifying the certificate. Once these have been provided, the document will be signed and will need to be 

saved on your computer. 

7. PDF document signed with a certified signature. 

 

5 pav. Example of a document signed with a certificate 

 

8. Upload the signed document to the BAP as described in "Generating and adding a certificate after logging into the portal". 
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5 SERVICE RECIPIENT REGISTRATION 

Only a registered user can register a new service recipient. To do this, log in to your registered user account and follow these steps: 

1. In the top menu, select "Choose another services recipient": 

 

Picture 1. Choose services recipient 

 

2. If you don't find recipient, register by choosing "Register new": 

 

Picture 2. Register new service recipient 

 

3. You will be directed to the page where you will need to choose the type of registration: via e-government gateway or submit a 

request. 

 

Picture 3. Choose the type of registration 

5.1 Services recipient registration on request 

1. On the screen "Application for registration of services recipient" click "Submit a request" button. 
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Picture 1. Choose the type of registration 

2. Fill out the form provided. This form has 5 steps: 

1) Legal person 

2) Address 

3) Contact details 

4) Notification reception type 

5) Review and submission 

Save the request by clicking the "Submit" button on Review and submission step: 
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Picture 2. Application for registration of services recipient 

 

The data will be transmitted to customs. 

The customs officers will contact you via e-mail address or telephone number specified in your registration request after examining 

your application or after examining and activating the account of the registered service recipient. 
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5.2 Service recipient registration by logging via e-government gateway 

1. On the screen "Application for registration of services recipient" click "Login with e-government gateway" button. 

 

Picture 1. Choose the type of registration 

2. You will be directed to a page where you can choose the authentication service method and provider. 

3. After authentication you will be directed to "Application for registration of services recipient" form of 5 steps: 

1) Legal person 

2) Address 

3) Contact details 

4) Notification reception type 

5) Review and submission 

Save the request by clicking the "Submit" button on "Review and submission" step: 



BAP USER GUIDE 

BENDRO NAUDOTOJŲ VALDYMO SISTEMOS, ATITINKANČIOS EUROPOS KOMISIJOS REIKALAVIMUS, SUKŪRIMO 
PASLAUGŲ PROJEKTAS 

 
 

 68 

 

Picture 2. Application for registration of services recipient 
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6 ADDITION OF A REPRESENTATIVE OF THE RECIPIENT OF SERVICES AND 

MANAGEMENT OF REPRESENTATION RIGHTS 

Recipient rights management functionality is available to users with administrator privileges. 

Managing agent rights includes adding representatives, terminating representation, assigning administrator rights, assigning 

activity profiles. 

6.1 Review of the list of representatives 

The list of representatives of the services recipient shall include all the representatives assigned to the services recipient. To view a 

list of agents or the details of a specific agent, follow these steps: 

1. Select "Representatives" tab from the top menu: 

 

Picture 1. Selecting the "Representatives" menu item 

 

2. The opened window shows the list of representatives assigned to the service recipient. Click the "View" button to view the 

details of a specific agent: 

 

Picture 2. List of service user representatives 

 

3. To view the data of a specific representative, click on the row of the representative's record in the list of service recipient's 

representatives and you will be redirected to the "Representative of services recipient" data view window. 

To view or edit the details of a specific representative, click on the row of the representative's record in the list of service 

recipient's representatives and follow the steps described in "Management of representation rights". 

 

6.2 Addition of a representative 

You can only add a person already registered in the Customs Information System to the services recipient you represent. 

The person who will be assigned as the services recipient must self-register with the BAP (the registration process is described in 

the section “User registration and data change”) and pass on the user identification number (RIN) assigned to the user by the user 

of the user. 
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1. It is displayed in the top bar below the Representatives's name as shown in the image below: 

 

Picture 1. User Identification Number (RIN) 

 

To add a recipient representative, follow these steps: 

2. In the top menu, select "Representatives" (see step 1 in the "Review of the list of representatives" section). 

In the window that opens, click the "+ Add Representative" button: 

 

Picture 2. Add representative 

 

3. In the window that opens, enter the user identification number (RIN) you want to add in the field "User ID number" and click the 

"Add" button: 

 

Picture 3. User identification number 

 

4. Make sure you really add the person you want. The user name found is displayed below the user identification number (RIN). 
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Picture 4. Name and surname of the found user 

 

5. By default, the added user is assigned all the activity profiles available to the service user. You can modify the assigned activity 

profiles by unchecking or re-checking the check-boxes, as shown in the image below: 

 

Picture 5. Business profiles 

 

6. If necessary, assign the user administrator rights to a user. Save your data by clicking the "Save" button. 

Note: The administrator right allows you to manage the rights of service user representatives and delegation agreements 
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Picture 6. Adding administrator rights 

6.3 Management of representation rights 

You can grant or revoke administrator rights and grant or revoke activity profiles to the recipient's representative. To manage 

representation rights, follow these steps: 

1. In the top menu select tab "Representatives". 

2. In the list of service recipient's representatives, select the row of the representative's record and you will be redirected to the 

service representative of services recipient data view window: 

 

Picture 1. List of services recipient's representatives 
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3. In the representative of services recipient preview window click the button „Edit“. 

 

Picture 2. Editing the rights of service user representatives 

 

4. In the window that opens, select the desired activity profiles and/or administrator rights by unticking or re-ticking the 

checkboxes as shown in the image below. 

Save your data by clicking on the "Save" button: 

 

Picture 3. Managing the rights of Service User Representatives 
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6.4 Removal of a representative 

To remove a representative from the list of recipients, follow these steps: 

1. In the top menu, select "Representatives" tab. 

2. In the list of service recipient representatives, click on the row of the representative's record and you will be redirected to the 

"Service recipient representative" data view window. 

 

Picture 1. List of service user representatives 

 

2. In the window that appears, click the "Remove" button. 

 

Picture 2. Selecting the "Remove" action 
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3. In the dialog box that opens, confirm that you want to remove the representative from the list of representatives by clicking on 

the "Remove" button. 

 

Picture 3. Confirmation of removal 
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7 REGISTRATION AND MANAGEMENT OF DELEGATION AGREEMENTS 

Delegation contract management functionality is available to users with administrator rights. 

The representative of the service recipient (delegator) may delegate the activity profiles assigned to the service recipient to 

authorised service recipient - the delegate, by creating a delegation agreement between these service recipients. The initiator of 

the delegation agreement is always the delegate. The delegation agreement enters into force when it is approved by the 

authorized recipient of services (delegate) and the date corresponds to the date of commencement of the agreement specified in 

the agreement. After the conclusion of the delegation agreement, the users representing the delegate may act as the delegate's 

representatives within the activity profiles provided for in the delegation agreement. The delegation agreement shall expire when 

it expires or is terminated by either party. 

7.1 Revision of the list of delegation agreements 

The list of delegation agreements shall include all agreements created by the recipient and/or assigned to the recipient. 

To view a list of delegation agreements or the details of a specific agreement, follow these steps: 

1. Select "Delegation agreements" tab in the top menu: 

 

Picture 1. Delegation agreements 

 

2. The window that opens provides a list of delegation agreements created and/or received by the service user. 

 

Picture 2. View the details of a specific delegation agreement 

 

3. To view the details of a specific delegation agreement, click on the row of the delegation agreement record in the list of 

delegation agreements and you will be redirected to the "Delegation Agreement" data view window. 

7.2 Creating a delegation agreement 

To create a delegation agreement, follow these steps: 

1. Select "Delegation agreements" in the top menu (see step 1 in the "Revision of the list of delegation agreements" section). 

2. In the window that opens, click the "+ Register New" button: 
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Picture 1. Register new delegation agreement 

 

3. Please provide the details of the authorized recipient (delegate). 

• If you want to delegate the activity profiles to a legal entity, in the Delegation Agreement creation window, tick that the 

authorized service recipient will be a legal person. Select and enter the legal entity identification code to be used: 

 

Picture 2. Details of the legal entity of the authorized recipient 

 

• If you want to delegate the activity profiles to a natural person, in the  in the delegation agreement creation window, tick that 

the authorized service recipient will be a natural person.  

 

Picture 3. Authorized recipient's natural person data 
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• Select an available identification code and provide the person's name, selected code and the registration identification 

number of the authorised service user's account. 

You can find the account number of the authorised recipient number by logging into your account and selecting the "Profile" 

tab, as shown in the image below:  

 

Picture 4. Services recipient's account identification number 

 

Note: You can only conclude a delegation agreement with a natural or legal person who is already registered in the Customs 

Information System. 

How to register a natural or legal person is described in the section "User registration and data modification" and click "Add" 

button: 

 

4. Once you have entered the service recipient's details, click the "Add" button: 

 

Picture 5. Adding an authorized recipient 

 

5. Make sure that the delegation agreement contains the correct details of the authorized services recipient. 

The details of the authorized services recipient shall be provided below the details of the services recipient creating the agreement. 

 

Picture 6. Authorized services recipient 
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6. Enter the details of the delegation agreement and specify the activity profiles you want to delegate. 

 

Picture 7. Specification of contract details and delegated activity profiles. 

 

7. Save the data by clicking the "Save" button: 

 

Picture 8. Save data 

 

Once the agreement is saved, it will be redirected to the authorized recipient. The representative of the authorized recipient with 
administrator rights will see the contract by logging into the Authorized services recipient's account which will be able to approve 
or reject upon review as described in "Approval and rejection of the delegation agreement". 
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7.3 Approval and rejection of the delegation agreement 

Once a delegation agreement has been created by the service recipient, it must be approved by the Authorized service recipient. A 

contract that is not approved is invalid. 

 

In order to approve a contract delegated to an authorised service recipient, the representative of the authorised service recipient, 

who has administrator right, must complete the following steps: 

1. Select "Delegation agreements" from the top menu. The window that opens shows a list of delegation agreements created 

and/or received by the service user. Contracts with a status of "Prepared" are awaiting approval. 

2. To approve a specific contract, in the list of delegation agreements, click on the row of the delegation agreement record whose 

status is "Prepared". You will be redirected to the data preview window of the selected delegation agreement. 

 

Picture 1.  Delegation agreement selection 

 

3. In the window that opens, click the "Accept" button: 

 

Picture 2.  Accept delegation agreement 
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4. To reject the delegation agreement, click the "Reject" button. 

5. In the dialogue window that opens, confirm that you want to reject the agreement by clicking on the "Reject" button. 

 

Picture 3.  Rejection of delegation agreement 

If the contract is rejected, it will be removed from the list of delegation agreements. 

7.4 Editing a delegation agreement 

The delegation agreement can be edited by the person who created it. Only a prepared agreement with the status "Prepared" is 

allowed to edit all fields. 

 

Once the contract has been approved by the Authorized Service Recipient (agreement status "Confirmed by delegator"), editing the 

contract allows changes to the assigned activity profiles and the agreement expiry date. 

Note: The result of editing a Delegation agreement with status "Confirmed by delegator" does not need to be approved by the 

Authorized service recipient. 

 

To edit a delegation agreement, follow these steps: 

1. Select "Delegation agreements" in the top menu. 

2. In the list of delegation agreements, click on the row of the delegation agreement record. You will be redirected to the data view 

window of the selected delegation agreement. 

 

Picture 1. Delegation agreement selection 

 

3. Click the "Edit" button and change the information you want in the contract details. Fields for which changes are not allowed are 

shown as inactive. 
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Picture 2. Edit delegation agreement 

 

4. Save your changes by clicking the "Save" button: 

 

Picture 3. Save edited delegation agreement 
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7.5 Termination of the delegation agreement 

An existing delegation agreement may be terminated by either party. To terminate the contract, follow these steps: 

1. Select "Delegation agreements" in the top menu. 

2. In the list of delegation agreements, click on the row of the delegation agreement record whose status is "Confirmed by 

delegator". You will be redirected to the data view window of the selected delegation agreement. 

 

Picture 1. Delegation agreement selection 

 

3. In the preview window, click the "Revoke" button. 

 

Picture 2. Termination of delegation agreement 
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4. In the dialogue that opens, confirm that you want to cancel the contract by clicking on the "Revoke" button. 

 

Picture 3. Confirmation of termination 

In the event of termination, the delegation agreement will be removed from the "Delegation agreements" list. 

 


